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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page humber. The humbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
PICkit™ Serial Analyzer User’s Guide. ltems discussed in this chapter include:

» Document Layout

» Conventions Used in this Guide

» Warranty Registration

* Recommended Reading

» The Microchip Web Site

» Development Systems Customer Change Notification Service

» Customer Support

» Document Revision History

DOCUMENT LAYOUT

This document describes how to use the PICkit™ Serial Analyzer as a development
tool to communicate with embedded development systems via serial protocols. The
manual layout is as follows:

» Chapter 1: PICKit™ Serial Analyzer Overview

« Chapter 2: Getting Started

« Chapter 3: PICkit™ Serial Analyzer PC Program

- Chapter 4: I2C™ Master Communications

« Chapter 5: SPI Master Communications

« Chapter 6: USART Asynchronous Communications

» Chapter 7: USART Master Synchronous Communications

* Chapter 8: User Defined Templates

» Chapter 9: PICkit™ Serial Analyzer Firmware

+ Chapter 10: PICKit™ Serial Analyzer DLL

© 2007 Microchip Technology Inc. DS51647A-page 1
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« Chapter 11: Troubleshooting
- Appendix A: Hardware Schematics
« Appendix B: 28-Pin Demo Board I2C™ Demo Firmware

CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

Atab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, R is the radix and n is a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OXFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]|1}

Ellipses...

Replaces repeated text

var name [,
var name. . .]

Represents code supplied by
user

void main

{
}

(void)

DS51647A-page 2
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly.
Sending in the Warranty Registration Card entitles users to receive new product
updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use the PICkit™ Serial Analyzer. Other useful
documents are listed below. The following Microchip documents are available and
recommended as supplemental reference resources.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in
the Readmes subdirectory of the MPLAB IDE installation directory. The Readme files
contain update information and known issues that may not be included in this user’s
guide.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

» Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

+ Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

+ Compilers — The latest information on Microchip C compilers and other language
tools. These include the MPLAB® C18 and MPLAB C30 C compilers; MPASM™
and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers;
and MPLIB™ and MPLAB LIB30 object librarians.

+ Emulators — The latest information on Microchip in-circuit emulators.This
includes the MPLAB ICE 2000 and MPLAB ICE 4000.

+ In-Circuit Debuggers — The latest information on the Microchip in-circuit
debugger, MPLAB ICD 2.

« MPLAB® IDE — The latest information on Microchip MPLAB IDE, the Windows®
Integrated Development Environment for development systems tools. This list is
focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager

© 2007 Microchip Technology Inc. DS51647A-page 3
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and general editing and debugging features.

* Programmers — The latest information on Microchip programmers. These include
the MPLAB PM3 and PRO MATE® Il device programmers and the PICSTART®
Plus and PICkit™ 2 development programmers.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

+ Local Sales Office

+ Field Application Engineer (FAE)
+ Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY
Revision A (January 2007)

« Initial release of this document.

DS51647A-page 4 © 2007 Microchip Technology Inc.
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Chapter 1. PICKit™ Serial Analyzer Overview

1.1 INTRODUCTION

The PICKkit™ Serial Analyzer development system enables a personal computer (PC)
to communicate with embedded development systems via serial protocols such as
I2C™, SPI, asynchronous and synchronous USART. The PC program uses a graphical
interface to enter data and commands to communicate to the target device. Data and
commands can be entered using basic or scripting commands. The PICkit™ Serial
Analyzer connects to the embedded development system using a 6-pin header.

The PICkit™ Serial Analyzer is a sophisticated and highly configurable device. Please
take a few moments to familiarize yourself with the hardware interface and PC program
by reading this user’s guide. Chapter 2. “Getting Started” will guide you through
installing the PC program and running a simple demonstration program on the 28-Pin
Demo Board (DM164120-3) using the 2C serial protocol.

1.2 HIGHLIGHTS

This chapter discusses:

» PICkit™ Serial Analyzer Contents

» PICkit™ Serial Analyzer Development System
» PICkit™ Serial Analyzer Hardware

+ PICkit™ Serial Analyzer PC Software

1.3  PICKkit™ SERIAL ANALYZER CONTENTS

The PICkit™ Serial Analyzer serial communications development system contains the
following items:

1. The PICkit™ Serial Analyzer

2. USB cable

3. PICkit™ Serial Analyzer CD-ROM

1.4  PICkit™ SERIAL ANALYZER DEVELOPMENT SYSTEM

The PICKit™ Serial Analyzer consists of several components that together make an
embedded serial communications development system. The PC program runs on
Microsoft® Windows® compatible computers with a USB port. The PICkit™ Serial
Analyzer connects to the PC using a USB cable. Finally, the PICkit™ Serial Analyzer
interfaces to the target device using a 6-pin header. Figure 1-1 illustrates the PICkit™
Serial Analyzer embedded serial communications development system.

© 2007 Microchip Technology Inc. DS51647A-page 5
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FIGURE 1-1: PICkit™ SERIAL ANALYZER DEVELOPMENT SYSTEM

PC

—
Device
USB ] ﬁ |2CTM

SPI
PICkit™ Serial Analyzer USART

1.5 PICkit™ SERIAL ANALYZER HARDWARE

The PICkit™ Serial Analyzer connects to a Microsoft® Windows® compatible computer
using a USB port. It interfaces to the target device using a 6-pin header. Figure 1-2
shows an overview of the PICkit™ Serial Analyzer.

FIGURE 1-2: PICkit™ SERIAL ANALYZER

Legend:
1 — Status LEDs 3 — Lanyard Connection 5 — Pin 1 Marker
2 — Push Button 4 — USB Port Connection 6 — Communications Connector

DS51647A-page 6 © 2007 Microchip Technology Inc.
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1.5.1 Status LEDs

The Status LEDs indicate the status of the PICkit™ Serial Analyzer.
1. Power (green) — Power is applied to the PICkit™ Serial Analyzer by the USB

port.

2. Target (yellow) — The PICkit™ Serial Analyzer is communicating with the target
device.

3. Busy (red) — The PICkit™ Serial Analyzer is communicating with the target
device.

1.5.2 Push Button

The push button is available for future implementation.

1.5.3 Lanyard Connection

To help prevent possible loss of the PICkit™ Serial Analyzer, a convenient lanyard
connection is available.

1.5.4 USB Port Connection

The USB Port Connection is a USB mini-B connector. Connect the PICkit™ Serial
Analyzer to the PC using the supplied cable.

1.5.5 Pin 1 Marker

The Pin 1 marker assists in aligning the PICkit™ Serial Analyzer with the target device.
Pin assignments are shown in Figure 1-3.
1.5.6 Communication Connector

The communication connector connects to the target device using an inexpensive
6-pin, 0.100" pitch spacing, 0.025” square pin header. Pin assignments are shown in
Figure 1-3.

FIGURE 1-3: PICkit™ SERIAL ANALYZER PIN ASSIGNMENTS
Pin 1 Indicator

Pin Description
1’c™ SPI USART

> 1 L — cS X
2 2 +V +V +V
Z 3 GND GND GND
5 4 SDA SDI —
6 5 SCL SCK —
6 — SDO  RX

Note: The 6-pin header (0.100" spacing) accepts 0.025" square pins.

© 2007 Microchip Technology Inc. DS51647A-page 7
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1.6  PICkit™ SERIAL ANALYZER SOFTWARE

1.6.1 PC Program

The PICkit™ Serial Analyzer PC program uses a graphical interface to enter data
and commands to communicate to the target device. Data and commands can be
entered using basic or scripting commands. Chapter 3. “PICkit™ Serial Analyzer
PC Program” explains the installation and operation of the program. Following
Chapter 3 there are individual chapters that explain the specific serial communica-
tions modes and their operation.

1.6.2 Dynamically Linked Library (DLL)

The PICkit™ Serial Analyzer DLL is explained in Chapter 10. “PICkit™ Serial
Analyzer DLL”.

1.6.3 Firmware

The PICKit™ Serial Analyzer firmware is explained in Chapter 9. “PICkit™ Serial
Analyzer Firmware”.

The latest version of the PICkit™ Serial Analyzer firmware can be downloaded from the
Microchip Technology web site. The firmware is updated by selecting PICkit Serial
Analyzer > Download PICkit Serial Analyzer Firmware from the menu bar. An open file
window will open. Select the *.hex file to be uploaded to the PICkit™ Serial Analyzer
and click on the Open button. The Firmware Download window will open as shown in
Figure 1-4 to indicate the status of the firmware update.

FIRMWARE DOWNLOAD WINDOW

F/W Clear Status —a
']Illmlll-ﬁ]l‘-m'l'mlllﬁﬂ

FIGURE 1-4:

=10l x|

Download Status [ -]
Q 20 0 a0 a0 100

F/W Read Status —a
']Illmlll-ﬁ]l‘-m'l'mlllﬁﬂ

Werily Stalus —a
[ 2 20 E El 100
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Chapter 2. Getting Started

2.1 INTRODUCTION

This chapter will get you started using the PICkit™ Serial Analyzer with the 28-Pin
Demo Board. In this demo, the PICkit™ Serial Analyzer will communicate with the
28-Pin Demo Board using the I°C serial protocol. The PICkit™ Serial Analyzer will be
the I°C Master and the 28-Pin Demo Board will be the 1°C Slave device. The 28-Pin
Demo board is programmed to emulate an I2C real-time clock and Serial EEPROM.

For more information about the 28-Pin Demo Board hardware, see the 28-Pin Demo
Board User’s Guide (DS41301).

For more information about the 28-Pin Demo Board 12C™ demo firmware, see
Appendix B. “28-Pin Demo Board I2C™ Demonstration Firmware”.

The demo program source code and *.hex file can be found on the PICkit™ Serial
CD-ROM at D:\28-pin Demo Board\Firmware\.

2.2 HIGHLIGHTS

This chapter discusses:

+ Installing the PICkit™ Serial Analyzer Software

» Connecting the PICkit Serial Analyzer to the PC

» Connecting the PICkit Serial Analyzer to the 28-Pin Demo Board
« Starting the PICkit Serial Analyzer Program

* Running The 28-Pin Demo I2C™ Demonstration Program

« 12C Communications — Basic Operations

« 28-Pin Demo 1°C™ Source Code and Firmware

2.3 INSTALLING THE PICkit™ SERIAL ANALYZER SOFTWARE

Insert the PICKit™ Serial Analyzer CD-ROM into the CD-ROM drive. In a few moments
the introductory screen should be displayed. Follow the directions on the screen to
install the PICkit Serial Analyzer software.

If the introductory screen does not appear, browse to the CD-ROM directory and select
the AutorunPro.exe program.

Note: The PICkit™ Serial Analyzer program requires the Microsoft® .NET
Framework Version 2.0. If the .NET Framework is not installed on your
computer (or if in doubt), select the application plus Microsoft® .NET
Framework installation.

2.4 CONNECTING THE PICKkit™ SERIAL ANALYZER TO THE PC

Connect the PICkit Serial Analyzer to the PC using the supplied USB cable. There are
no USB drivers to install. The green Power indicator should light indicating that the
PICkit Serial Analyzer is powered.

© 2007 Microchip Technology Inc. DS51647A-page 9
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2.5 CONNECTING THE PICKkit™ SERIAL ANALYZER TO THE 28-PIN DEMO
BOARD

Connect the PICkit Serial Analyzer to P3 on the 28-Pin Demo Board as shown in Figure
2-1. The PICkit Serial Analyzer will supply power to the 28-Pin Demo Board and
perform a power on routine:

« LEDs will flash in sequence DS1, DS2, DS3, DS4, DS3, DS2, and DS1 twice

« All LEDs will turn off

* All LEDs will turn on

« All LEDs will turn off

« LEDs will display in hexadecimal: A, D, C

» LEDs will display the top 4 bits of the ADC value read from potentiometer RP1

FIGURE 2-1: CONNECTING PICkit™ SERIAL TO THE 28-PIN DEMO
BOARD

2.6 STARTING THE PICkit™ SERIAL ANALYZER PROGRAM

You can start the program by:

« Clicking on the desktop icon, or

» Navigating to Start>All Programs>Microchip>PICkit Serial Analyzer

After a few moments, the program will start and display the main window as shown in
Figure 2-2.

If this is the first time you are running the program, the Configuration Wizard will auto-
matically run. Click on the Next button and accept the default settings for 12C Master
mode. For more information about using the I°C Master mode, see Chapter 4. “I2C™
Master Communications.”

DS51647A-page 10 © 2007 Microchip Technology Inc.
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FIGURE 2-2: PICKit™ SERIAL ANALYZER MAIN WINDOW
i

Communications  PICk Serial Analyzer  DemoBoards  User Defined Templates  Wiew  Window  Help

: View: Basic | Communications: Basic Operations | Reset

File = Edit = Clear

1/5/2007 12:43:35 AW

|

wWelcome to PICkit Serial wi E!Jfﬂg_llf_.étmhwj'laf‘_‘ﬂ‘.
Found PICkitS.d1l - ver: 1.

= Welcome To The
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2.7 RUNNING THE 28-PIN DEMO I°C™ DEMONSTRATION PROGRAM

Select the 28-Pin Demo 1°C demonstration by clicking on Demo Boards > 28 Pin Demo
EC from the menu bar. The 28-Pin Demo I°C demonstration window will be displayed
as shown in Figure 2-3.

The Real-Time Clock (RTC) will be displayed first. Note the tabs to select between the
RTC, EEPROM and ADC demonstrations. The demonstration program will constantly
poll the 28-Pin Demo Board and display the contents of the real-time clock and the
ADC.

2.7.1 Real-Time Clock (RTC)

Clicking on the Real-Time Clock tab will display calendar and clock contents of the
real-time clock function running on the 28-Pin Demo Board. The 28-Pin Demo Board
has been programmed to emulate a stand-alone serial I°C clock-calendar device. The
I°C commands are very similar to the commands used in these devices. The demon-
stration program will constantly poll the 28-Pin Demo Board and display the contents
of the real-time clock.

The Real-Time Clock window displays calendar and clock controls. Notice the date and
time when the 28-Pin Demo Board has first been powered on. The date and time start
at January 1, 2000 at midnight (12:00 AM).

The user can manually enter calendar and clock values and send the values to the
real-time clock by clicking on the Update RTC button. Or the user can click on the Set
RTC to System Time button to set the real-time clock to the date and time of the
computer.
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FIGURE 2-3: 28-PIN DEMO I12C™ — RTC
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2.7.2 Serial EEPROM (EEPROM)

Clicking on the EEPROM tab will display the 256 byte array of EEPROM memory as
shown in Figure 2-4. The 28-Pin Demo Board has been programmed to emulate a
stand-alone serial ’°C EEPROM device such as a 24LC02. The 1°C commands are
very similar to the commands used in these devices.

The Serial EEPROM tab displays the contents of a serial EEPROM implemented on
the 28-Pin Demo Board. When this tab is first displayed, the values are grayed out. This
means that the display does not match the contents of the emulated serial EEPROM.
Click on Read EE button and the program will read and display the contents of the
28-Pin Demo Board. Notice that the displayed values are now black.

Individual memory locations can be changed by clicking on the value and typing in a
new value in hexadecimal. Notice that the changed values will be displayed in red. This
means the value has changed but has not been written to the emulated serial
EEPROM. Click on the Write EE button and the values will be written. The color of the
value will turn to black indicating that the value has been written and the display
matches the contents of the emulated serial EEPROM.

DS51647A-page 12
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FIGURE 2-4: 28-PIN DEMO 12C™ — EEPROM
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2.7.3 Analog-to-Digital Converter (ADC)

Clicking on the ADC tab will show a meter gauge displaying the value of the ADC as
read from potentiometer RP1 as shown in Figure 2-5.

The meter gauge displays the Most Significant 8 bits of the 10-bit ADC internal to the
PIC® microcontroller. Rotate potentiometer RP1 and the display changes almost
instantaneously. The demonstration program will constantly poll the 28-Pin Demo
Board and display the contents of the ADC.

FIGURE 2-5: 28-PIN DEMO I°C™ — ADC
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2.8 I°C™ COMMUNICATIONS — BASIC OPERATIONS

Individual 1°C commands and data can be read and written to the 28-Pin Demo Board
from the Basic Operations window as shown in Figure 2-6. Ensure that the PICkit Serial
Analyzer program is in I°C Master mode by selecting PICkit Serial Analyzer > Run Con-
figuration Wizard from the menu bar and selecting 1°C Master.

Note: The 28-Pin Demo I2C window and the Basic Operations window cannot be
opened at the same time. When the 28-Pin Demo I2C window is opened,
the Basic Operations window will automatically close.

Address[W]  Address

FIGURE 2-6: I2C™ BASIC OPERATIONS
Basic =0l x|
2z |
— Read
Slave “Ward Statuz .

El x x I_Sl x E Execute

il

Clear

— Write
Slave ‘Word

Address[]  Address Data

[ = < | xﬂﬁ
=
[ < <

Status [

Execute

Clear

il

2.8.1 Real-Time Clock (RTC)

The Slave address for the emulated real-time clock on the 28-Pin Demo Board is
hexadecimal A2 (OxA2). The Word Address selects the following memory locations:

TABLE 2-1: MEMORY LOCATIONS

Word Address Contents
0x00 Configuration 1
0x01 Configuration 2
0x02 Seconds
0x03 Minutes
0x04 Hours
0x05 Days
0x06 Weekdays
0x07 Months
0x08 Years

DS51647A-page 14
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For example, to read seconds from the real-time clock:

Step 1 — Enter 0xA2 into the Slave Address[W] block in the Read section of the Basic
Operations window (top half of window)

Step 2 — Enter 0x02 into the Word Address block

Step 3 — Note that the Slave Address[R] has already been entered for you (the Read
bit is set).

Step 4 — Enter 0x01 into the Byte Count block

Step 5 — Click on the Execute button

The I2C combination command (Write then Read) will be sent to the 28-Pin Demo
Board. The command and the contents of Word Address 0x02 (seconds) will be
displayed in the transaction window as shown in Figure 2-7.

FIGURE 2-7: RTC TRANSACTIONS DEMO

Transactions = =)=

File = Edit = Claar

Sent I2C Read Cmd:
[_J[Az][0z] [RE][A3][01][P_]

[=_][2e][rP-]

2.8.2 EEPROM

The Slave address for the emulated Serial EEPROM on the 28-Pin Demo Board is
hexadecimal A8 (0xA8). The Word Address selects one of 256 8-bit memory locations:

TABLE 2-2: WORD ADDRESS CONTENTS

Word Address Contents
0x00 Memory Contents
OxFF Memory Contents
2.8.3 ADC

The Slave address for the ADC on the 28-Pin Demo Board is hexadecimal AA (0xAA).
The Word Address 0x01 selects the memory location containing the Most Significant 8
bits of the 10-bit ADC of the PIC microcontroller.

2.9 28-PIN DEMO I>°C™ SOURCE CODE AND FIRMWARE

The demo program source code and *.hex file can be found on the PICkit Serial
CD-ROM at D:\28-pin Demo Board\Firmware)\.
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NOTES:
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Chapter 3. PICKit™ Serial Analyzer PC Program

3.1 INTRODUCTION

This chapter covers the installation, starting and high level operations of the PICkit
Serial Analyzer program. Detailed information about the entering of data and com-
mands for specific serial communications modes are given in the following chapters.

3.2 HIGHLIGHTS

This chapter discusses:

* Installing The PICkit Serial Analyzer Software
+ Starting the Program

+ Configuration Wizard

+ Main Window

+ Specific Communications Modes

3.3 INSTALLING THE PICkit™ SERIAL ANALYZER SOFTWARE

Insert the PICKit Serial Analyzer CD-ROM into the CD-ROM drive. In a few moments
the introductory screen should be displayed. Follow the directions on the screen to
install the PICkit Serial Analyzer software.

If the introductory screen does not appear, browse to the CD-ROM directory and select
the AutorunPro.exe program.

Note: The PICkit Serial Analyzer program requires the Microsoft® .NET
Framework Version 2.0.

3.4 STARTING THE PROGRAM

You can start the program by
» Clicking on the desktop icon, or
+ Navigating to Start>All Programs>Microchip>PICkit Serial Analyzer

After a few moments, the program will start and display the main window as shown in
Figure 3-1.
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FIGURE 3-1: PICkit™ SERIAL ANALYZER MAIN WINDOW
i
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View: Basic | Reset Basic Communications | 12C_M
B Status
= B
File + Edit » Clear | H i i
EBitRate: 100.0 kHz
roe Woltage: 4 84/
1/3/2007 2:49:15 FM Data Line Voltage: 4.7%

Clock Line Woltage: 4.74
welcome to PICkit Serial wersion Beta MDI 1.0.9

Found PICkitS.d11 - Ver: 1.3.0.0

Found PICkit Serial Analyzer - FW Wer: 0=0108

USE control block updated with preference data.

Basic View Set.

3.5 CONFIGURATION WIZARD

If it is the first time that the PICkit Serial Analyzer program is run, the Configuration Wiz-
ard will run automatically. The Configuration Wizard can be manually invoked by select-
ing PICkit Serial Analyzer > Run Configuration Wizard from the menu bar.

The Configuration Wizard will guide you through the basic steps to configure the PICkit
Serial Analyzer program for a specific communications mode (1°C, SPI, USART).
Advanced configuration can be done from the Configuration Window by selecting PIC-
kit Serial Analyzer > Configure Communications Mode from the menu bar.

As an example, Figure 3-2 through Figure 3-7 show how to configure for 1°C Master
mode. Refer to the specific communications chapter for detailed information on the
Configuration Wizard for that communications mode.

The Configuration Wizard Welcome window is shown in Figure 3-2. You may choose
to continue by clicking on the Next button or canceling the wizard by clicking on the
Cancel button.
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FIGURE 3-2: CONFIGURATION WIZARD — WELCOME

=
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< Back | MNest > I Cancel |

The Configuration Wizard Page 1 of 4, as shown in Figure 3-3, displays the available
communications modes and allows you to choose one of the modes.

FIGURE 3-3: CONFIGURATION WIZARD - PAGE 1 OF 4

Configuration Wizard

Communication Mode - Page 1 of 4
Choose which mode of communication vou wish to uze,

% |2C Master

5P Master

" USART Async
 USART Spnc Master

< Back | Mext > | Cancel |

In this example, 1°C Master Communication’s mode is selected. The Configuration
Wizard Page 2 of 4, as shown in Figure 3-4, allows you to select the bus speed. A more
comprehensive list of bus speeds can be chosen from the Configuration Window by
selecting PICkit Serial Analyzer > Configure Communications Mode from the menu bar.
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